User Guide:
Illinois National Guard (ING)

- Access and Navigation
- Student Eligibility
- Payment Processing
Introduction to ING Processing

The Illinois National Guard (ING) Program is administered by schools using the ING system, which is available through ISAC’s Gift Assistance Programs (GAP) Access portal at **https://isacportal.isac.org**. ING information is accessed by selecting the ING tab near the top of the screen once the school user has successfully logged into GAP Access. Student eligibility information is accessed via the Student tab, and payment processing, when it becomes available for an award year, is accessed via the Payment tab.

Quick links to ISAC contact information, the FAA section of ISAC’s website and ING program information can be found at the bottom of all ING system screens, as seen below:

Please note that the system will time out after prolonged inactivity. The following message will appear to allow you to save your data:

**Warning! Due to inactivity, your session has expired. Please save any data you may have entered before refreshing the page.**
Student List Eligibility: View Screen

The Student List Eligibility: View screen is accessed from the Student tab (See prior page). On the Student List Eligibility: View screen, schools are able to view students who have listed their school as one of the school choices on the ING Application.

This provides the entry point to other ING functions such as: viewing detailed student information, viewing student information history, creating reports, and associating ING codes with selected students.

The initial loading of the Student List Eligibility: View page will result in a default view with the following columns:

- Benefits
- Sel (Select)
- Current SSN (last four digits display)
- Last Name
- First Name
- Date of Birth
- ISAC Default
- Application Receipt Date
- Certified Date
- Certified Eligible
Student List Eligibility: View Screen

The screen shots below illustrate the type of data that is provided on the Student List Eligibility: View screen.

The icon provides a link to more detailed information about the student, and the $ icon provides a link to the Benefits Usage (Payment) information for the student (Available Fall 2015). In the column next to the $ icon, a light bulb icon - - will be displayed if any flags are on that could cause the student to be ineligible for an award. Keep in mind that not all flags make a student totally ineligible for an award. It is up to the school to determine the meaning of the flag and to what extent it affects the student’s potential award.

### ING 2015-2016: Student List Eligibility: View

<table>
<thead>
<tr>
<th>#</th>
<th>Benefits</th>
<th>S</th>
<th>Current SSN</th>
<th>Last Name</th>
<th>First Name</th>
<th>Date of Birth</th>
<th>ISAC Dfit</th>
<th>ING Units Used</th>
<th>Application Receipt Date</th>
<th>Certified Date</th>
<th>Certified Eligible</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$</td>
<td></td>
<td>xxx-xx</td>
<td>MIRANDA</td>
<td>11/19/1994</td>
<td>N</td>
<td>12</td>
<td>05/26/2015</td>
<td>07/07/2015</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>$</td>
<td></td>
<td>xxx-x</td>
<td>BEN</td>
<td>11/18/1989</td>
<td>N</td>
<td>30</td>
<td>06/24/2015</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>$</td>
<td></td>
<td>xxx-xx</td>
<td>MICHAEL</td>
<td>08/27/1978</td>
<td>N</td>
<td>9</td>
<td>06/23/2015</td>
<td>07/07/2015</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>$</td>
<td></td>
<td>xxx-x</td>
<td>ANGELO</td>
<td>06/30/1995</td>
<td>N</td>
<td>0</td>
<td>06/29/2015</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>$</td>
<td></td>
<td>xxx-xx</td>
<td>TIMOTHY</td>
<td>11/24/1989</td>
<td>N</td>
<td>10</td>
<td>07/02/2015</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>$</td>
<td></td>
<td>xxx-x</td>
<td>STEPHEN</td>
<td>04/27/1987</td>
<td>N</td>
<td>66</td>
<td>06/30/2015</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Showing 1 to 6 of 6 entries

Save Selected  View Report
Student List Eligibility: View Instructions

The Student List Eligibility: View screen displays a maximum of one hundred student records. To view more records, click on the Previous Page, Pages 1-10, or Last Page tabs. To view additional columns, scroll to the right. Other suggestions for viewing the eligibility screen are listed below.

- To select students enrolled in or attending your institution, select them by clicking on the box in the “Sel” column.

- To view the student’s ING eligibility data on the Student Detail: Eligibility screen, click on the magnifying glass icon that is on the same line as the student’s last name.

- To view the Benefits Usage (Payment) page, click on the dollar sign icon.

- To filter your view, displaying only those student records that you want to see, click on the Filter Tab. The Student List Eligibility: Filter screen will be displayed with the various filter options.

- To sort the student records, click on the Sort tab. The Student List Eligibility: Sort screen will be displayed.

- To view a report of a Student List Eligibility: View screen, click on the “View Report” button located at the bottom of the screen. A copy of the report can be created in .PDF format by clicking on the “View Report” tab.
Student List Eligibility: Filter Screen

The Student List Eligibility: Filter screen allows you to designate student records that you want to view on the Student List Eligibility: View screen by selecting parameters for the records that you want to see. After selecting your filtering criteria, click on the View tab to see your customized list.

For example, if you want to view only those students with a last name of Love, go to the Last Name field, select the “=” sign from the drop down menu and enter Love in the text box next to the “=” sign. When you return to the Student List View by clicking on the View tab, you will see only those students with a last name of Love.

The Filter screen allows you to filter on more than one option, and it can also be used in conjunction with the options available through the Sort and Columns tabs.

ING 2015-2016 : Student List Eligibility: Filter

Check boxes on the right side of the screen allow you to filter your lists even further. For example, to view just your eligible students, check the “Eligible Students Only” box. In addition, the eligibility status of records can be viewed by selecting the ineligible conditions.

In addition to viewing the customized list in the ING system, you can also view and save the report as a .PDF file by clicking on the View Report tab located at the bottom of the Student List Eligibility: View screen.
The Student List Eligibility: Sort screen allows the user to designate the order in which the records will appear on the Student List: View screen. The default view of the Student List View is Last Name, First Name. By using the Sort function, you can change the order in which records are sorted, which can be helpful when trying to compare records to your institutional reports that may be sorted in a different order. The Sort screen can be accessed from the Student List Eligibility: View screen by clicking on the Sort tab.

To select Sort categories: highlight the item in the Unselected list and click on the arrow icon to move it to the Selected list. To select more than one item at a time, hold down the Ctrl key while highlighting the items, then click on the arrow icon.

To remove an item from the Selected list: highlight the item in the Selected column and click on the arrow icon to move it to the Unselected list. To select more than one item at a time, hold down the Ctrl key while highlighting the items, then click on arrow icon.

Moves the highlighted item from the Unselected list to the Selected list.
Moves all of the items in the Unselected list to the Selected list.
Moves the highlighted item from the Selected list to the Unselected list.
Moves all of the items in the Selected list to the Unselected list.

To rearrange the items once they are selected, highlight the column title by clicking on it, then click on the Move Column Up or the Move Column Down button until the items are positioned in the order in which you want them to sort.

To sort in descending order, select the appropriate checkboxes. Unchecked checkboxes will be sorted in ascending order.
Student List Eligibility: Columns Screen

The Student List Eligibility: Columns Screen allows the user to select columns to display on the Student List Eligibility: View screen. Clicking on the Columns tab on the Student List Eligibility: View screen will access the Student List Eligibility: Columns screen.

To add a Column: highlight the item in the Unselected list and click on the arrow icon to move it to the Selected list. To select more than one item at a time, hold down the Ctrl key while highlighting the items, then click on the arrow icon.

To remove a Column: highlight the item in the Selected list and click on the arrow icon to move it to the Unselected list. To select more than one item at a time, hold down the Ctrl key while highlighting the items, then click on arrow icon.

- Moves the highlighted item from the Unselected list to the Selected list.
- Moves all of the items in the Unselected list to the Selected list.
- Moves the highlighted item from the Selected list to the Unselected list.
- Moves all of the items in the Selected list to the Unselected list.

If you want to rearrange the columns once they are selected, select the column you want to change by clicking on it. When the column is highlighted, click on the Move Column Up button, or click on the Move Column Down button until the column is in the correct place.
The Student Detail: Eligibility screen displays information from the student's ING application as well as certification and eligibility information for ING. The purpose of this screen is to allow authorized users the ability to view the ING eligibility details of an individual student record. The Student Detail: Eligibility screen is accessed by clicking on the magnifying glass icon - on the Student List Eligibility: View screen.

To select another student's Detail screen, enter a new Social Security Number in the Current SSN field and click on the Go button.
Here is a closer look at the Student Detail: Eligibility screen, including the student information section, the Details section, and the School Certification Data section.

### Value Description of Eligibility Codes

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y</td>
<td>Eligible</td>
</tr>
<tr>
<td>N</td>
<td>Not Eligible</td>
</tr>
<tr>
<td>Blank</td>
<td>Not Yet Certified</td>
</tr>
</tbody>
</table>

### Value Description of 10-Year Member Codes

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y</td>
<td>10-Year Member</td>
</tr>
<tr>
<td>Blank</td>
<td>Less Than 10-Year Member</td>
</tr>
</tbody>
</table>

### Code Definition of Default Code

<table>
<thead>
<tr>
<th>Code</th>
<th>Definition of Default Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y</td>
<td>Student is currently in default on an ISAC student loan.</td>
</tr>
<tr>
<td>N</td>
<td>Student is not currently in default on an ISAC student loan.</td>
</tr>
</tbody>
</table>

### Value Description of Eligibility As of Date

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Most recent date eligibility was determined</td>
</tr>
<tr>
<td>Blank</td>
<td>Eligibility not yet determined</td>
</tr>
</tbody>
</table>

### ING Units Used

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>ISAC Default</td>
</tr>
</tbody>
</table>

### Eligibility As Of Date

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>06/26/2015</td>
<td>Eligibility As Of Date</td>
</tr>
</tbody>
</table>

---
The ING Eligibility Report displays students that may be eligible for the Illinois National Guard (ING) grant. The Reports screen is accessed from the Reports tab. To generate a report, first click the Create New Report button in the upper right-hand corner of the screen. Then, select the report type from the Select Report drop-down menu and click on the Request Report button.
The ING File Extraction lists students that may be eligible for the Illinois National Guard (ING) grant in an electronic format. The Reports screen is accessed from the File Extractions tab. To generate an extraction, first click the Create New File Extraction button in the upper right-hand corner of the screen. Then, select ING Eligibility Status File from the Select Report drop down menu and click on the Request Report button.